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Abstract 

 
Augmented Reality (AR) is an interactive experience of a real-world environment where the 

objects that reside in the real world are enhanced by computer-generated perceptual 

information, sometimes across multiple sensory modalities, including visual, auditory, haptic, 

somatosensory and olfactory. 

 

LATHE MACHINE is a machine tool that rotates a workpiece about an axis of rotation to 

perform various operations such as cutting, sanding, knurling, drilling, deformation, facing, and 

turning, with tools that are applied to the workpiece to create an object with symmetry about 

that axis.  

 

In our project we have developed an application in which we have made use of AUGMENTED 

REALITY technology to help students learn LATHE Machine anytime time anywhere without 

physically having that machine with them. As the student coming from first year to second year 

and they are totally unaware of lathe machine and its operations. In order to make students 

familiar to lathe operations, This APP will help student to relate with lathe machines and its 

operations virtually .Only the thing required is an android phone and the application that we 

have developed. First the student will have to choose from the different operations provided in 

the application which he/she wants to learn. Application will then detect the ground plane and 

a LATHE Machine will be superimposed over the real-life ground displayed on the mobile 

device. Then the students can learn how to perform different operations. Besides this hand on 

can also be played by the students in the application but that will not be on AR mode but will 

be in 3D console mode. 

 

Keywords : Augmented Reality, Lathe Machine 
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CHAPTER 1 

 

INTRODUCTION TO AUGMENTED REALITY 

 

Augmented reality (AR) is an interactive experience of a real-world environment where the 

objects that reside in the real world are enhanced by computer-generated perceptual information 

sometime across multiple sensory modalities, 

including visual, auditory, haptic, somatosensory and olfactory. AR can be defined as a system 

that fulfils three basic features: a combination of real and virtual worlds, real-time interaction, 

and accurate 3D registration of virtual and real objects. The overlaid sensory information can 

be constructive (i.e. additive to the natural environment), or destructive (i.e. masking of the 

natural environment). This experience is seamlessly interwoven with the physical world such 

that it is perceived as an immersive aspect of the real environment. In this way, augmented 

reality alters one's ongoing perception of a real-world environment, whereas virtual 

reality completely replaces the user's real-world environment with a simulated one. Augmented 

reality is related to two largely synonymous terms: mixed reality and computer-mediated 

reality. 

Figure 1.1: Illustration of Augmented Reality 
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The primary value of augmented reality is the manner in which components of the digital world 

blend into a person's perception of the real world, not as a simple display of data, but through 

the integration of immersive sensations, which are perceived as natural parts of an environment. 

The earliest functional AR systems that provided immersive mixed reality experiences for users 

were invented in the early 1990s, starting with the Virtual Fixtures system developed at the U.S. 

Air Force's Armstrong Laboratory in 1992. Commercial augmented reality experiences were 

first introduced in entertainment and gaming businesses. Subsequently, augmented reality 

applications have spanned commercial industries such as education, communications, 

medicine, and entertainment. In education, content may be accessed by scanning or viewing an 

image with a mobile device or by using marker less AR techniques.  

 

Figure 1.2: Augmented Reality in Military 

 

             Augmented reality is used to enhance natural environments or situations and offer 

perceptually enriched experiences. With the help of advanced AR technologies (e.g., 

adding computer vision, incorporating AR cameras into smartphone applications and object 

recognition) the information about the surrounding real world of the user 

becomes interactive and digitally manipulated. Information about the environment and its 

objects is overlaid on the real world. This information can be virtual or real, e.g., seeing other 

real sensed or measured information such as electromagnetic radio waves overlaid in exact 

alignment with where they actually are in space. Augmented reality also has a lot of potential 

in the gathering and sharing of tacit knowledge. Augmentation techniques are typically 

performed in real time and in semantic contexts with environmental elements.  
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1.1  TYPES OF AUGMENTED REALITY 

   

• MARKER-BASED AR 

• MARKERLESS AR 

• PROJECTION BASED AR 

• SUPERIMPOSTION AR 

     Figure 1.3: Types of Augmented Reality 

 

1.1.1 MARKER-BASED AR 

  

         Marker-based augmented reality (ar) markers are images that can be detected by a camera 

and used with software as the location for virtual assets placed in a scene. Most are black and 

white, though colours can be used as long as the contrast between them can be properly 

recognized by a camera. Augmented reality that relies on markers is the most 

widespread approach to the immersive technology implementation. Marker -based 

ar or image recognition uses a mobile device camera to detect a predefined mar ker 

that then triggers a certain computer-generated content. Markers can be ar-codes, 
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physical objects, or printed images as it appears in the  absolute vodka augmented 

reality app. To enable the ar app to recognize a real -world object as a trigger, a 

certain marker should be embedded into this object. Since ar -codes are much easier 

to recognize for both cameras and users, this type of marker is greatly used by 

augmented reality programmers. As soon as a marker appears within a camera 

scene, the software calculates the position of both a marker and displayed content. 

Therefore, a change of the real-world object position will influence the position of 

the computer-generated content. The better an app can determine certain physical 

objects, the more accurate the disposition of the overlaid digital information will 

be. 

Figure 1.4: Illustration of marker-based AR 

  A camera is used with AR software to detect augmented reality markers as the location for 

virtual objects. The result is that an image can be viewed, even live, on a screen and digital 

assets are placed into the scene at the location of the markers. Limitations on the types of 

augmented reality markers that can be used are based on the software that recognizes them. 

While they need to remain fairly simple for error correction, they can include a wide range of 

different images. The simplest types of augmented reality markers are black and white images 

that consist of two-dimensional (2D) barcodes. 

PROS: -  

• If the marker image is prepared correctly, marker-based AR content provides quality 

experiences and tracking is very stable, the AR content doesn’t shake 

• Easy to use, detailed instructions are not required for people who use it for the first time 
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CONS: - 

•  When the mobile camera is moved away from the marker, AR experience disappears 

and the trigger photo has to be scanned again. It is possible to use extended tracking, 

but in most cases, extended tracking makes things worse. 

• Scanning will not work if markers reflect light in certain situations (can be challenging 

with large format OD banners in ever-changing weather conditions) 

• Marker has to have strong borders/contrast between black and white colours to make 

tracking more stable. Smooth colour transition will make recognition impossible 

 

1.1.2 MARKERLESS AR 

 

      Markerless AR places virtual 3D objects in the physical environment depending on the 

environment’s real features rather than identifying markers. This differentiation eliminates the 

need for object tracking systems. Markerless AR experiences are possible because of 

advancements in cameras, sensors, processors, and algorithms capable of accurately detecting 

and mapping the real-world. Marker less augmented reality works by scanning the surrounding 

environment and there is no trigger photo necessary to retrieve the augmented reality content. 

 

 

Figure 1.5: Illustration of Marker Less AR 

 

Apps that offer such features usually will ask the user to find a flat surface such as a table or 

floor for placing the AR elements as the objects will not always make sense floating in the air. 

For computer vision to detect the flat surface, it has to be textured. You will find it challenging 

or even impossible to use on a white background or on other single color surfaces. 
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  PROS: - 

• Once the content is placed in a room, it is more flexible than marker-based alternatives. 

• Increase range of motion with AR 

• Wider field of view for AR content 

    CONS:-  

•  The augmented reality content may not make sense in a certain context. 

• For better experience, it is required that the surface has a texture for computer vision to 

recognize it. 

 

1.1.3 PROJECTION BASED AR 

 

     This is one of the simplest types of AR that projects light onto a surface. Projection-based AR 

is an engaging and interactive way of interacting by touching light on the surface and touching 

the surface on which the interaction is projected. The widespread use of projection-based AR 

technology can be used to create tricks for the position, orientation, and depth of objects. In this 

case, the user can consider other objects and their structure to study depth. This  

Figure 1.6: Projection Based Ar 

technology offers so much more in every sense. This technique is used to create virtual objects 

for much larger batches to experience augmented reality for AR app development        Projection 

Augmented Reality, sometimes also referred to as “spatial Augmented Reality,” is a method of 

delivering digital information to users within a stationary context. Target objects and  
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users can move around in the environment, but the zone in which AR experiences take place is 

limited to the fields of view of both the fixed projector and supporting camera for tracking. 

The first example of projection Augmented Reality was called the “Digital Desk.” In November 

1991, within months of their contemporaries at Boeing, Tom Caudell and David Mizell, coining 

the term “Augmented Reality,” William Newman and Pierre Wellner, then researchers at 

University of Cambridge and Xerox europarc, published a paper in the UIST 1991 conference 

proceedings called the digitaldesk Calculator: Tangible Manipulation on a desktop display. 

Projection-based Augmented Reality (PBAR) is a new concept that extends the capabilities of 

projection-based VR (immersive projection technology) towards AR by using semi-transparent 

mirrors as opti-cal combiners. Commonly known stereo glasses  (active or passive ones) are 

sufficient to see a 3-dimensional scene, consisting of a real/physical part and a virtual part.  

 

PROS:-  

• Reduces or eliminates the need for computer monitors and screens, as the instructions 

appear directly in the task space. 

• Reduces users’ cognitive load when following work instructions due to the fact that 

there is no need for “attention switching” between work instructions and the task at 

hand. 

• Integrates into manual workflows by promoting a “no faults forward” policy to ensure 

and confirm correct execution of the preceding step. 

• Provides feedback on completed tasks for process improvement, traceability and unique 

digital IDs for build cycles. 

CONS:- 

➢ The augmented reality content may not make sense in a certain context. 
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1.1.4 SUPERIMPOSITION AR 

 

The word itself describes the nesting of the target. This AR provides an alternative view of the 

focused object. This is done by replacing the full or partial view with an enlarged view of the 

object. Object recognition here plays an important role in replacing the view of an object with 

an augmented view. Superimposition based AR provides an ‘alternate’ view of the object in 

concern, either by replacing the entire view with an augmented view of the object or by 

replacing a portion of the object view with an augmented view. In this case, once again, object 

recognition plays a vital role - logically, if the application does not know what it is looking at, 

it most certainly cannot replace the original view with an augmented one. 

 

     

                   Figure 1.7: Illustration of Superimposition Based AR 

 

Depending on what type of view is required, the technology can be used for multiple purposes. 

 

1.Doctors can use the technology to examine the patient from various angles in real-time. A 

live feed from an X-Ray machine can be used to superimpose the X-Ray view of the patient‘s 

body part on the real image to provide better understanding of the damage to bones. The 

application can be made to work via a head mounted display or special goggles. In other uses, 

the view can be shown on a screen where the video feed is taken from a real camera and X-Ray 

vision can be imposed on it. 
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2. In military applications, superimposition-based AR can provide multiple views of a target 

object without showing extra information in text and blocking the vision of soldier from other 

important objects around. If you have been shooting enemies via your computer mouse, you’d 

already know how it would appear. Superimposition of infrared view or radioactive view of an 

object or an area can help save lives; or win wars! 

 

3. Superimposition of ancient pictures over real ones can provide interesting views of historical 

places. Broken monuments can come back to life in all their original glory. Perhaps different 

eras complete with landscapes can be re-lived with AR. 

 

4. To allow a tiger or snake near you might be a horrifying experience with hazardous 

consequences, except when superimposition AR is used to bring them to you. Placing a person 

in a location or situation which is otherwise dangerous can be can be safely accomplished via 

superimposition AR! 

 

5. Superimposing a real object with its internal view can be helpful in education as well, for 

instance, to study bone structure. Though we have touched some of the most important types 

of augmented reality, there are a few others which cannot be easily classified to fall in one of 

the above said ones.  

 

 

 

 

 

 

 

 

 

 

 

 

 

IR@AIKTC-KRRC

ir.aiktclibrary.org



 

VIRTUAL TRAINING OF LATHE MACHINE USING AUGMENTED REALITY 

 

Department of Mechanical Engineering, AIKTC, New Panvel, Navi Mumbai                                                       10 

 
 

1.2 DIFFERENT BETWEEN VIRTUAL REALITY (VR) AND   AUGMENTED  

REALITY(AR) 

 

SR NO. AUGMENTED REALITY VIRTUAL REALITY 

1 

 

Here the user sees the real 

world and receives 

additional information 

Here the user no longer perceives the real 

environment 

2 

 

A smartphone, tablet, head-

up display, holography 

system or augmented reality 

glasses like the Microsoft 

Hololens are required to 

experience this 

The user can only experience the digital 3D 

world with aids such as VR glasses 

  

 

3 The system augments the 

real-world scene 

Completely immersive virtual environment 

4 In AR User always have a 

sense of presence in the real 

world 

In VR, visual senses are under control of the 

system 

5 This technology partially 

immerses the user into the 

action  

This technology fully immerses the user into 

the action 

6 AR requires upwards of 100 

Mbps bandwidth  

VR requires at least a 50 Mbps connection 

7 AR is 25% virtual and 75% 

real  

VR is 75% virtual and 25% real 

8 No AR headset is needed.

  

Some VR headset device is needed. 

9 It is used to enhance both 

real and virtual worlds.

  

It is used to enhance fictional reality for the 

gaming world. 
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10 

 

With AR, end-users are still 

in touch with the real world 

while interacting with 

virtual objects nearer to 

them.  

 

By using VR technology, VR user is isolated 

from the real world and immerses himself in a 

completely fictional world. 

 

 

1.3.1 ADVANTAGES AND DISADVANTAGES OF AUGMENTED   REALITY 

 

➢ ADVANTANGES 

• Offers individualized learning 

• Fostering the learning process 

• Wide variety of fields 

• Offers innovation and continuous improvement 

• Increase accuracy 

• Augmented reality can be used to increase user knowledge and information. 

• People can share experiences over long distances. 

• Helps developers to build games that offer "real" experience to the user.  

 

➢ DISADVANTAGES. 

 

• It is very expensive to implement and develop AR technology-based projects and to 

maintain it. 

• Extreme engagement with AR technology can lead to major healthcare issues such as eye 

problems and obesity etc. 
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1.4  PROJECT SCOPE AND OBJECTIVES. 

 
1.4.1 PROJECT SCOPE. 

 

i To Develop an Android Application to Train The Students To Operate Lathe Machine 

Virtually Using Augmented Reality Technology. 

ii Apart from Lathe Machine, Other Machines Such as Drill Machine, Milling Machine Etc. 

Can Also Be Added In This App Using Augmented Reality Technology 

iii This Application Can Be Uploaded to Play Store. 

iv Students Across Various Colleges Can Download from Play Store and Can Take the 

Advantage of This App. 

 

1.4.2 PROJECT OBJECTIVES. 

i The Main Objective Is to Create an Android App Using Augmented Reality for Students 

to Learn the In-Depth Knowledge Of Lathe Machines (Its Parts, Operations Etc.)  

ii Before Going for The Actual Practical’s of The Lathe Machines Students Can First Learn 

the Basics of The Machine Virtually Using Augmented Reality Technology. 

iii Students Can Learn Lathe Machine Operation Anytime, Anywhere Without Any Physical 

Interaction of Machine. 
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CHAPTER 2 

LITERATURE REVIEW 

       The aim of this article is to analyze and review the scientific literature relating to the 

application of Augmented Reality (AR) technology in industry. AR technology is becoming 

increasingly diffuse, due to the ease of application development and the widespread use of 

hardware devices (mainly smartphones and tablets) able to support its adoption. Today, a 

growing number of applications based on AR solutions are being developed for industrial 

purposes. Although these applications are often little more than experimental prototypes, AR 

technology is proving highly flexible and is showing great potential in numerous areas (e.g., 

maintenance, training/learning, assembly or product design) and in industrial sectors (e.g., the 

automotive, aircraft or manufacturing industries). It is expected that AR systems will become 

even more widespread in the near future. 

 

The purpose of this review is to classify the literature on AR published from 2006 to early 2017, 

to identify the main areas and sectors where AR is currently deployed, describe the 

technological solutions adopted, as well as the main benefits achievable with this kind of 

technology. 

 

 The review papers provide a summary of the existing literature about different aspects of AR 

solutions and applications. These papers propose general state-of-the-art analyses of AR 

technologies (Carmigniani et al., 2011), with a focus in the main patents (De Lucia et al., 2011), 

as well as in the manufacturing context (Ong et al., 2008). Other studies review AR systems 

that can be used for specific purposes, such as to enhance human computer interaction (HCI) 

(Igarashi and Inami, 2015; Rajendran et al., 2015) or human-robot collaboration (Green et al., 

2008). Several papers analyse AR applications devoted to a particular industrial task; the most 

investigated tasks are assembly (Stork and Schubö, 2010; Leu et al. 2013; Wang et al., 2016a) 

, maintenance (Oliveira et al., 2013; Lamberti et al. 2015), design (Nee et al., 2012; Yin et al., 

2015), safety/ergonomics (Hovanec et al., 2014) and food logistics (Vander roost et al., 2017). 

  

IR@AIKTC-KRRC

ir.aiktclibrary.org



 

VIRTUAL TRAINING OF LATHE MACHINE USING AUGMENTED REALITY 

 

Department of Mechanical Engineering, AIKTC, New Panvel, Navi Mumbai                                                       14 

 
 

 

Technical Review 

These are the following softwares that we have used for the application we developed:- 

 

• AR Core:- 

ARCore is a software development kit developed by Google that allows for augmented reality 

applications to be built. ARCore uses three key technologies to integrate virtual content with 

the real world as seen through your phone’s camera: 

1.Motion tracking allows the phone to understand and track its position relative to the world. 

2.Environmental understanding allows the phone to detect the size and location of flat 

horizontal surfaces like the ground or a coffee table. 

3.Light estimation allows the phone to estimate the environment’s current lighting conditions. 

 

• Unity:- 

Unity is a cross-platform game engine developed by Unity Technologies. Unity gives users the 

ability to create games and experiences in both 2D and 3D, and 

the engine offers a primary scripting API in C, for both the Unity editor in the form of plugins, 

and games themselves, as well as drag and drop functionality. 

As of 2018, Unity had been used to create approximately half of the mobile games on the market 

and 60 percent of augmented reality and virtual reality content, including approximately 90 

percent on emerging augmented reality 

platforms, such as Microsoft HoloLens, and 90 percent of Samsung Gear VR content. Unity 

technology is the basis for most virtual reality and augmented 

reality experiences, and Fortune said Unity ”dominates the virtual reality business”. 

 

• Blender:- 

Blender is a free and open-source 3D computer graphics software toolset used for creating 

animated films, visual effects, art, 3D printed models, motion graphics, interactive 3D 

applications, and computer games. Blender’s features include 3D modelling, UV unwrapping, 

texturing, raster graphics editing, rigging and skinning, fluid and smoke simulation, particle 

simulation, soft body simulation, sculpting, animating, match moving, rendering, motion 

graphics, video editing, and compositing. 
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• 3DS Max:- 

3ds Max is a computer graphics program for creating 3D models, animations, and digital 

images. It’s one of the most popular programs in the computer graphics industry and is well 

known for having a robust toolset for 3D artists. 

A favourite among game developers, TV commercial studios, and architects, 3ds Max is owned 

by Autodesk, the same company responsible for programs like Maya and AutoCAD. 

 

➢ Advantages of Technology 

a. ARCore is Software Development Kit(SDK) for creating augmented reality apps. 

The best thing about ARCore is that it supports development for both Android 

(7.0 and higher) IOS platforms (11 or higher). 

b. ARCore offers points, plane detection, pose, light estimation, anchors, image 

tracking, face tracking, object occlusion, and cloud anchors. 

c. ARCore supports many existing devices eliminating the need for any specific 

hardware, e.g. a specialized camera or sensor. 

d. The ARCore development toolkit is available for free. 

 

➢ Reasons to use this Technology 

a. ARCore provides SDK for developing AR apps which will work on both popular 

devices i.e. Android(version 7.0 and later) and IOS(version 11 and later) . 

b. ARCore offers a very good accuracy while detecting planes and edges. 

c. With the capabilities of real-time position tracking and integration of virtual and 

real objects, ARCore is a great tool for AR in this type’s apps. 

 

➢ Microsoft Visual Studio 

Microsoft Visual Studio is an integrated development environment (IDE) from Microsoft. It is 

used to develop computer programs, as well as websites, web apps, web services and mobile 

apps. Visual Studio uses Microsoft software development platforms such as Windows 

API, Windows Forms, Windows Presentation Foundation, Windows Store and Microsoft 

Silverlight. It can produce both native code and managed code. Visual Studio supports 36 

different programming languages and allows the code editor and debugger to support (to 

varying degrees) nearly any programming language, provided a language-specific service 

exists. Built-in languages include C,[7] C++, C++/CLI, Visual Basic, 

.NET, C#, F#,[8] JavaScript, TypeScript, XML, XSLT, HTML, and CSS 
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CHAPTER 3 

OVERVIEW OF LATHE MACHINE 

 

3.1 INTRODUCTION TO LATHE MACHINE. 

 

Lathe machine is a general-purpose machine tool, which is used for machining different round 

objects. We can do different operation on the job by lathe machine. It is commonly used in the 

mechanical field. It makes the work easier and simplify. A lathe machine is a machine tool that 

is used to remove metals from a workpiece to give a desired shape and size. Lathe Machines 

are used in metalworking, woodturning, metal spinning, thermal spraying, glass working, and 

parts reclamation. 

The various other operations that you can perform with the help of Lathe Machine can include 

sanding, cutting, knurling, drilling, and deformation of tools that are employed in creating 

objects which have symmetry about the axis of rotation. 

Mostly the simple jaws we can make on lathe machine tool. It is easy to install and easy to work 

on it. The Lathe is the most versatile machine tool among all standard of the machine tool. 

Nowadays the manually controlled machine exists like a CNC machine and even do with the 

help of feed mechanism the lathe machine operates manually 

Figure 3.1: Lathe Machine 
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3.2 MAJOR PARTS OF THE LATHE MACHINE. 

i Headstock 

Headstock is a major part of lathe machine which is on the left side of the lathe machine. 

This part of lathe machine is made up of cast iron. In this part the all mechanism of 

consolation of machine available in this part. All gears and mother which is used to start 

and stop to the machine available in this part. There is some sub part of the headstock 

which is important to discuss like (motor, gears, chuck, spindle, clutch) etc. 

ii Tailstock. 

Tailstock is  the one of  most important  part of lathe machine. It is on the right side of 

the machine. It is made up of cast iron by casting. It is also consisting of some sub part’s 

like (tailstock spindle, tailstock lock lever, tailstock wheel, tailstock lock spindle lock 

lever) etc. 

iii Bed 

Bed is base of lathe machine which is consist of two or four feet. All the structure of 

lathe machine is based on the bed of lathe machine. It is made up of cost iron by the 

casting. Under the bed of lathe machine there are some racks are available for the putting 

tool’s, jaws, or the other parts of the lathe machine. 

iv Carriage 

Carriage is also a main part of the lathe machine which is in between the headstock and 

the tailstock. It is also made up of the cast iron by the casting. It slides on the bed ways 

which are  on  the  bed  of  the  lathe  machine.  Its motion  is  too  and  frown  between  

the headstock and the tailstock on the bed ways. It  is  also  consisting  of  some  subparts  

like (carriage  wheel,  carriage  auto  feed  lever, cross slide, compound slide, tool post, 

tool post lock lever) etc 

v Cross slide 

The Cross-slide move on the cross-slide keyways on the carriage. It moves vertical to 

the jab. The purpose of the cross slide is the make the depth of the cut of tool on the jab. 

we can rotate it at any angle when we need mostly on the tapper cutting etc. 

vi Compound slide 

The compound slide offers a way to turn tapers and cut angles on a lathe without rotating 

the headstock. cutting tool can be mounted across the front or on either side of the head 
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vii Tool post 

Tool post is used for the clamping the tool on the lathe machine. We can clamp any tool 

for the operation in the tool post. There are many types of the tool post which we use on 

the lathe machine. 

3.3 LATHE OPERATIONS. 

A. TURNING: 

It is the most common type of operation in all lathe machine operations. Turning is the 

operation of removing the excess material from the workpiece to produce a cylindrical surface 

to the desired length. The job held between the centre or a chuck and rotating at a required 

speed. The tool moves in a longitudinal direction to give the feed towards the headstock with 

proper depth of cut. The surface finish is very good. 

 

B. FACING: 

It is an operation of reducing the length of the workpiece by feeding the perpendicular to the 

lathe axis. This operation of reducing a flat surface on the end of the workpiece. For this 

operation, regular turning tool or facing tool may use. The cutting edge of the tool should set 

to the same height as the centre of the workpiece. 

• Facing consist of 2 operations 

 • Roughing: Here the depth of cut is 1.3mm  

• Finishing:  Here the depth of cut is 0.2-0.1mm. 

 

C.  CHAMFERING OPERATION: 

It is the operation of getting a beveled surface at the edge of a cylindrical workpiece. This 

operation is done in case of bolt ends and shaft ends. Chamfering helps to avoid damage to 

the sharp edges and protect the operation getting hurt during other operations. Chamfering on 

bolt helps to screw the nut easily.  
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D. KNURLING OPERATION:  

It is an operation of obtaining a diamond shape on the workpiece for the gripping purpose. 

This is done to provide a better gripping surface when operated by hands. It is done using a 

knurling tool. The tool consists of a set of hardened steel roller, and it is held rigidly on the 

tool post.  Knurling is done at the lowest speed available on a lathe. It is done on the handles  

and also in case of ends of gauges. The feed varies from 1 to 2 mm per revolution. Two or 

three cuts may be necessary to give the full impression. 

 

E. DRILLING 

The tailstock of a lathe can be used for drilling, with the aid of a drill chuck attachment. 

The drill chuck has a morse taper shaft which can be push into the shaft of the tailstock, 

locking it in position. The usual starting point for drilling with a centre lathe is to use a 

countersink bit. 

 

The usual starting point for drilling with a centre lathe is to use a countersink bit. This is used 

to drill slightly into the material and creates a starting point for other drills that are going to 

be used. Attempting to drill with a traditional drill bit without countersinking first will lead to 

the drill bit slipping straight away. It is not possible to drill a hole successfully or safely with 

out using a centre drill first. 

 

F. TAPER TURNING 

A taper turning is the gradual reduction in diameter from one portion of a cylindrical 

workpiece into another portion as a machining process doing in a lathe machines. Tapers can 

be external or internal. 
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CHAPTER  4 

ALL ABOUT 3DS MAX 

4.1 WHAT IS 3DS MAX? 

      3ds Max is a computer graphics program for creating 

3D models, animations, and digital images. It’s one of 

the most popular programs in the computer graphics 

industry and is well known for having a robust toolset 

for 3D artists. A favorite among game developers, TV 

commercial studios, and architects, 3ds Max is owned by Autodesk, the same company 

responsible for programs like Maya and AutoCAD. 

 

Figure 4.1:  Modelling Of Sofa Chair And Kettle Using 3ds Max 

 

       3ds Max is often used for character modeling and animation as well as for rendering 

photorealistic images of buildings and other objects. When it comes to modeling 3ds Max is 

unmatched in speed and simplicity. The software can handle several stages of the animation 

pipeline including pre-visualization, layout, cameras, modeling, texturing, rigging, animation, 

VFX, lighting, and rendering. As one of the most widely used 3D packages in the world, 3ds 

Max is an integral part of many professional studios and makes up a significant portion of their 

production pipeline for games and movies. 
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4.2 WHAT DOES 3DS MAX DO? 

        3ds Max is used in the video game industry for creating 3D character models, game assets, 

and animations. With an efficient workflow and powerful modelling tools 3ds Max can save 

game artists a significant amount of time. Also popular for TV commercials and film special 

effects, 3ds Max is often used to generate graphics for use alongside live action work. The 

movies 2012 and Avatar both made use of 3ds Max in this way.3ds Max fits into the animation 

pipeline at nearly every stage. From modelling and rigging to lighting and rendering, this 

program makes it easy to create professional quality animations easier and simpler.     

Many industries use 3ds Max for generating graphics that are mechanical or even organic in  

 

Figure 4.2: Use Of 3ds Max Avtar Movie Scene 

 

nature. The engineering, manufacturing, educational, and medical industries all make use of 

3ds Max for visualization needs as well. 

The real estate and architectural industries use 3ds Max to generate photorealistic images of 

buildings in the design phase. This way clients can visualize their living spaces accurately and 

offer critiques based on real models.3ds Max uses polygon modelling which is a common 

technique in game design.. 
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Figure 4.3: Polygon Modelling Tools 

 

   After a model is completed, 3ds Max can then be used to generate the materials and textures 

necessary to really bring things to life. Adding surface details such as colours, gradients, and 

textures will lead to higher quality renders and game assets. 

There are several rendering options available in the software. 

 

   Skilled CG artists will be able to create photorealistic images using techniques designed to 

mimic nature. 3ds Max is also capable of toon shading and other stylized techniques popular in 

video games.3ds Max can create realistic simulations of fluids such as smoke and water,   

 

        Rigid body physics in 3ds Max allows for the simulation of hard bodies such as rock and 

wood. These simulation tools create shatter effects and rag-doll physics in ways that other 

software can’t handle. Combined with a highly customizable particle effects system, these 

features can generate impressive photorealistic images and animations from scratch. 
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Figure 4.4: Character Modelling Using 3ds Max 

 

For creating life-like character models, 3ds Max provides simulations for hair, skin, clothes, 

and fur. And the many plugins available online reduce the development time for these types of 

models. With its own scripting language, flexible plugin architecture, and customizable user 

interface, 3ds Max can be personalized to fit the needs of any 3D work. 

 

4.3 WHO USES THE SOFTWARE? 

       3ds Max really caters to architectural designers and game asset artists the most. As for 

rigging and animation, 3ds Max has everything necessary for professional work. So it is often 

used by professional animators working on big budget films, indie films, or even smaller 

commercial spots that need some 3D motion. Using skeletons, bone constraints, and kinematics, 

artists can animate characters using a really simple process that almost anyone could pick up 

with practice. Animation in 3ds Max revolves around keyframing bone properties, making it 

easy to create complex and organic motion. 
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. 

Figure 4.5: Use Of 3ds Max In Architectural Field 

 

This software comes with two subsystems for animating character models: CAT and character 

studio. Each is fully customizable with a wide variety of applications. Both are compatible with 

motion-capture file formats too. And together they provide a powerful means of animating 

complex and detailed scenes 

Figure 4.6: Modelling Of Zombie Game Object Using 3ds Max 

 

      . 
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4.4 THE LATHE MACHINE IS DESIGNED USING 3DS MAX  

• Following are the parts of the LATHE Machine: 

• Part Name:  Tail Stock  

3DS Max Tools used: Standard Primitives (Box, cylinder), Splines (Line, rectangle, circle), 

Uniform scale tool, select and rotate tool, editable poly tool, Selection tools to select 

geometry’s (vertices, edges, faces, objects), extrude tool. 

Description:   Tailstock is a movable casting located opposite to headstock on the ways of 

bed. Tailstock slides along to accommodate different lengths of workpiece being worked 

out. It has internal taper to hold the dead center and tapered shank tools such as reamers and 

drills. Dead center supports the workpiece. 

      Main Parts:  Handle, Drill bit locking mechanism, tray. 

 

Figure 4.7: Tailstock Modelling 

 

• Part Name: Bed 

3DS Max Tools used: Standard primitives (Box), splines (Line, rectangle), editable poly, 

Compound object tools, Boolean (subtract), extrude tool. 

Description: Bed is the base where all the LATHE parts are mounted. The bed of the 

LATHE is the major structural element of the LATHE. The bed provides a foundation for 

the ways, which in turn carry the carriage, tailstock, and other components such as steady 

rests and carriage stops. It is generally made up of cast iron. 
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Figure 4.8: Bed  

 

• Part Name: Tool Post 

3DS Max Tools used: Spline tool (lines and Rectangle), standard primatives (cylinder), 

extrude tool, Boolean (add), cut, weld, cap, editable poly, flip. 

Description:  It is situated at the top of the carriage. It holds the tool or the tool holder. 

Main parts: Tool post handle, screws. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.9: Tool Post 
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• Part Name: Lead Screw 

3DS Max Tools used: Standard primitive (cylinder), Spline (circle, line), extrude tool, 

bridge, cap, flip, weld, editable poly (vertices, faces, edges), alignment, chamfer, Boolean 

(Add). 

Description: It helps in precise longitudinal movement of carriage. 

While performing the threading operation the lead screw is engaged 

 

 

Figure 4.10: Lead Screw 

 

• Part Name: Chuck 

3DS Max Tools Used: standard primitives (cylinder), Spline (circle, line), extrude tool, 

curve, copy(duplicate), editable poly, Boolean (subtract, add), attach tool. 

Description: It is a part of the tailstock. It's function is to hold the raw material or the 

work piece tightly. Typically, it is used to hold a rotating workpiece, such as a bar, and 

some can also hold irregularly shaped objects that lack radial symmetry. It is actuated 

under power that comes from the motor. 
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Figure 4.11: Chuck 

 

• Part Name: Carriage 

3DS Max Tools used: Spline (lines, circle), standard primitives (box), extrude, Boolean 

(add, attach, subtract), weld, cap, editable poly. 

Description: Carriage is located between headstock and tailstock. The basic function of the       

carriage is to support, guide, and feed the tool against the job during operation. 

Main parts: Saddle, cross slide, compound rest, tool post, apron, Handles. 

 

 

Figure 4.12: Carriage 
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• Part Name: Compound Rest. 

3DS Max Tools used: spline (rectangle, line, circle), editable poly, rotate, scale, extrude, 

align, Boolean (union, add), attach, copy. 

Description: Compound rest is present on the top of the cross slide. It supports the tool post 

and cutting tool in its various positions. Compound rest is necessary for turning  

angles and boring short tapers and forms on forming tools. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.13: Compound Rest 

• Part Name: HSS Tool. 

3DS Max Tools Used: Standard primatives (box), spline (line), cut, trim, extrude, editable 

poly, Boolean (add). 

Description: It performs the machining operation on the workpiece. It is made up of High-

Speed Steel. If it losses it's form it's form can be regained by performing grinding operation 

on its cutting edge. 

 
Figure 4.14: HSS Tool 
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• Part Name: Chuck key. 

3DS Max Tools used: standard primitives (cylinder, box), editable poly, Boolean (add, 

attach). 

Description: Its function is to tighten and untighten the chuck jaws to hold the workpiece 

in the chuck. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.15: Chuck Key 

 

• Part Name: Drill Chuck Key 

3DS Max Tools used: standard primitives (cylinder), weld, spline(line) , copy (duplicate), 

editable poly. 

Description: It's function is to tighten and untighten the jaws of the drill chuck, so that the 

drill bit can be fitted inside the drill chuck. 

 

Figure 4.16: Drill Chuck Key 
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• Part Name: Drill Chuck 

3DS Max Tools used: standard primitives (cylinder, cone), spline (line, circle, rectangle), 

scale, editable poly, Boolean (add, union, subtract), attach, cap, weld, extrude. 

Description: It consists of a jaws. Its function is to hold the drill bit tightly while performing 

the drilling operation. It is inserted in tailstock so that the drilling operation can be 

performed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.17: Drill Chuck 

• Part Name: Power Button. 

3DS Max Tools used: scale tool, rotate tool, spline (line, rectangle), standard primatives 

(sphere), editable poly, Boolean (union). 

Description: It is situated at the top of the machine. It is connected with the power supply. 

It can be turned left or right. Turning each direction gives us different rotation of the 

chuck. 

Figure 4.18: Power Button 
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• Part Name: Knurling Tool 

3DS Max tool used: standard primitives (box) , spline (line, circle), editable poly, Boolean 

(add) , attach, scale. 

Description: A knurling tool is used to press a pattern onto a round section. The pattern is 

normally used as a grip for a handle. 

Figure 4.19: Knurling Tool 

 

• Part Name: Feed Gear box 

3DS Max Tools used: standard primitives (cylinder), splines (rectangle, lines , circle), cap, 

weld, delete, copy(duplicate), editable poly, Boolean (add, subtract, union, attach). 

Description: When you machine different materials, even if the geometry of the job is 

similar, you would generally have to use different speed and feed values for an optimized 

machining process. Optimization could be done for different purposes such as for maximum 

metal removal rate or for the desired surface finish. This would require changing the speed 

at which your job is rotating (RPM) and the speed at which the cutting tool is fed (feed). 

And this is where a gear box comes into the picture. 

Figure 4.20: Gear Box 
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CHAPTER 5 

Software Requirements Specification 

 
 

5.1 Overall Description 

 

5.1.1 Product Perspective 

 

In our project we have developed an application in which we have made use of AR 

technology to help students learn LATHE Machine anytime time anywhere without 

physically having that machine with them. Only the thing required is an android phone and 

the application that we have developed. First the student will have to choose from the 

different operations provided in the application which he/she wants to learn .Application 

will then detect the ground plane and an LATHE Machine will be superimposed over the 

real life ground displayed on the mobile device. Then the students can learn how to perform 

different operations. Besides this hands on can also be played by the students in the 

application but that will not be on AR mode but will be in 3D console mode. 

 
5.1.2 Product Features 

 

The 3D object tracking allows the users to place LATHE Machine on the screen anywhere 

as per the wish of the user. 

Image recognition is used to identify objects, walls and floors. 

Unity support is used for making powerful effects. 

AR Core is used for motion tracking and environmental understanding. 

 
5.1.3 User Classes and Characteristics 

 

This project is specifically made for  helping out our students and our teachers they must be 

an android user. With the help of the application installed in the phone they can take the 

training of LATHE Machine anytime anywhere. 

 
5.1.4 Operating Environment Software Requirements 

 

• Android Nougat and above. 

• Android API Level 27 and above. 
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Hardware Requirements 

 

• Minimum 2 GHz Processor. 

• Minimum 3GB Ram. 

• At Least 8 MP Camera. 

 

5.2 System Feature 

 

3D object tracking provides the users the ability to place 3D objects on the screen. 

 

Description and Priority 

This is an important feature of the system. It enables the user to place three dimensional 

objects anywhere on the screen. Hence, the LATHE Machine can be placed anywhere 

in the room virtually which will help to visualize how it will look in real life. 

 

Stimulus/Response Sequences 

Stimulus: User taps on the LATHE Machine which he wants to move. 

Response: Object is selected. 

Stimulus: Drags the object to a particular place of his own choice. 

Response: The LATHE Machine moves as per the user’s will. 

Stimulus: User places the LATHE Machine where he wants. 

Response: The LATHE Machine is placed where the user was willing to place. 

 
Functional requirements: 

REQ-1:Should be given access to camera. 

 
5.3 External Interface Requirements 

 
5.3.1 Hardware Interfaces 

 

This application requires permission of some of the hardware commodities. One 

need to give camera access in-order to capture the picture. 

 
5.3.2 Software Interfaces 

 

The software’s that we have used for this application are Unity, which is a cross platform 

game engine. Its engine offers a primary scripting API in C. 3DS Max is also 
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used for creating the 3D models of the objects. AR Core is used for motion tracking, 

environmental 

understanding and light estimation. 

 

 

5.4 Nonfunctional Requirements 

 

Performance Requirements 

Performance of overall system is very efficient and well optimize. All the processes are 

well set everything is well organized. While processing an operation, it may take the same 

time for the other operations. 

Figure 5.1: System Architecture 

 

5.5 System Architecture Design 

 

A system architecture is the conceptual model that defines the structure, behavior, and more 

views of a system. An architecture description is a formal description 

and representation of a system, organized in a way that supports reasoning about the structures 

and behaviors of the system.   
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CHAPTER 6 

INTEGRATING AUGMENTED REALITY IN UNITY SOFTWARE 

6.1 GOOGLE AR CORE 

6.1.1 Introduction 

ARCore, also known as Google Play Services for AR, is a software development kit developed 

by Google that allows for augmented reality applications to be built. 

ARCore uses three key technologies to integrate virtual content with the real world as seen 

through your phone's camera  

• Six degrees of freedom allows the phone to understand and track its position relative to the 

world. 

• Environmental understanding allows the phone to detect the size and location of flat 

horizontal surfaces like the ground or a coffee table. 

• Light estimation allows the phone to estimate the environment's current lighting conditions. 

ARCore has been integrated into a multitude of devices. 

 

6.1.2 Integrating ARCore in Unity 

1. Download ARCore SDK for Unity 1.24.0 or later. 

The SDK is downloaded as arcore-unity-sdk-1.24.0.unitypackage. 

2. Open Unity and create a new 3D project. 

3. Unity 2019 only: Select Window > Package Manager and install the following 

packages: 

1. Multiplayer HLAPI (required by the CloudAnchors sample) 

2. XR Legacy Input Helpers (required by Instant Preview, which uses 

the TrackedPoseDriver) 

4. Import the ARCore SDK for Unity: 

• Select Assets > Import Package > Custom Package. 
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• Select the arcore-unity-sdk-1.24.0.unitypackage that you downloaded. 

• In the Importing Package dialog, make sure that all package options are selected and 

click Import. 

5. In the Unity Project window, you can find the HelloAR sample in: 

Assets/GoogleARCore/Examples/HelloAR/Scenes/. 

 

6.1.3 Configure Project Settings 

1. Go to File > Build Settings to open the Build Settings window. 

2. Under Platform, select Android and click Switch Platform. 

3. Click Player Settings. 

4. In the Android settings tab, configure the following settings: 

Section Setting Configuration 

Other Settings Rendering Uncheck Auto Graphics API. 

If Vulkan is listed under Graphics APIs, remove it. 

Multithreaded Rendering Select this option to use multithreaded rendering. 

 

Note: 

• When building for Android, the Multithreaded 

Rendering option is supported in ARCore SDK 

for Unity 1.17.0 or later. However, when this 

option is enabled in Unity 2018.1 and earlier, 

using the front-facing (selfie) camera is not 

supported. 

• 3D assets may not always render correctly when 

an app places a high load on the rendering thread. 

Package Name Create a unique app ID using a Java package name 

format. 

For example, use com.example.helloAR. 
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Scripting Backend When building for 64-bit devices, set the Scripting 

Backend to IL2CPP. See ARCore 64-bit requirement for 

more information. 

Target Architectures When building for 64-bit devices, 

select ARM64 (requires Scripting Backend set 

to IL2CPP). See ARCore 64-bit requirement for more 

information. 

Minimum API Level Select Android 7.0 'Nougat' (API Level 24) or higher. 

For AR Optional apps, the Minimum API level is 14. 

XR Settings ARCore Supported Enable this option. 

 

6.2 WORKING IN UNITY  

• First install all the packages required for Google AR Core from package manager and 

android studio from official website. 

• Now open the HelloAR scene from the scene folder and this is the default scene. In this 

scene we will add canvas and attach all the buttons and the buttons in turn will be attached 

to respective function. 

• All this will be done through coding script in the Microsoft Visual Studio. Let’s take turning 

operation, the complete process will be illustrated with example below 

 

 
Figure 6.1: Unity Interface 
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Figure 6.2: Scene Panel 

 

• In this panel we have the Hierarchy, Project, Scene panels and to add animation we will 

first click on the first part which is the chuck key and click on record animation 

 

 
Figure 6.3: Animation Panel 

 

• To record the animation, click on the red button and when the recording starts click on 0 

seconds so this becomes your starting point and then on 5 seconds and set the value of 

rotation of x axis as 180. Now the chuck key will rotate from 0 to 180 in 5 seconds.  

• For every step create a new animation and name it as Turning1. By this it will be easy to 

create and access all animations. 
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Figure 6.4: Adding Animations 

 

• Record the first animation of rotating the chuck key and name it as Turning1. In this way 

record all the animations of each step and arrange them in sequence in the animator panel. 

 

 
Figure 6.5: Adding Canvas 

 

• Canvas is basically screen on which we add Buttons, Dropdown Menu, Options Button. 

Canvas screen first appears when the app is started. On our main screen canvas, we have 

Quit, Parts, Free Play, Operations Menu, Instructions panel. All the buttons added here will 
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be linked to their respective function. For e.g., when you click on instructions button the 

instructions screen will appear because we have linked the button to it. 

Figure 6.6: Adding Buttons to Canvas 

 

• To add buttons right click in the Hierarchy panel > UI > Buttons. After the button is added  

 

Figure 6.7: Testing App In Game Panel 

• After successfully adding the animations and captions the app can be tested by connecting 

your mobile to your pc / laptop. Go to Game panel and click on the Play button and then 

the app will play in your phone directly. 
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Figure 6.8: Building The App 

• After the app is ready, we have to build the APK so we go to File > Build Settings then 

select android. Then go to Player settings and add the details such as App name, Icon, 

Supported android versions, etc. After this we click on Build and then unity exports the 

project in APK file format which we can install in the phone. 

6.3 SCRIPTS 

• For every step, button, action there is a script. For every function which takes place there 

is a script. To link the next and previous buttons with the animation we have the controller 

script and so on.  Also, on the main menu for each button there is a script linked to it. The 

script will decide what action will take place when the user interacts with the application. 

• The following script is the Google ARCore script which defines the vertical and horizontal 

planes , camera activation function, surface detection process, plane geometry, placing the 

game object in the environment. 

namespace GoogleARCore.Examples.HelloAR 

{ 

    using System.Collections.Generic; 

    using GoogleARCore; 

    using GoogleARCore.Examples.Common; 

    using UnityEngine; 

    using UnityEngine.EventSystems; 

    using UnityEngine.UI; 

    using UnityEngine.SceneManagement; 

    using TMPro; 
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#if UNITY_EDITOR 

    // Set up touch input propagation while using Instant Preview in the editor. 

    using Input = InstantPreviewInput; 

#endif 

    /// <summary> 

    /// Controls the HelloAR example. 

    /// </summary> 

    public class HelloARController : MonoBehaviour 

    { 

        public TMP_Dropdown Dropdown; 

 

        public List<GameObject> ModelsList; 

         

        public Animator LethAnim; 

        int count; 

 

        public Camera FirstPersonCamera; 

        GameObject Leth; 

        public bool placed; 

 

        public static int modelSelected; 

 

        /// <summary> 

        /// A prefab for tracking and visualizing detected planes. 

        /// </summary> 

        public GameObject DetectedPlanePrefab; 

 

        /// <summary> 

        /// A model to place when a raycast from a user touch hits a vertical plane. 

        /// </summary> 

        public GameObject AndyVerticalPlanePrefab; 

 

        /// <summary> 

        /// A model to place when a raycast from a user touch hits a horizontal plane. 

        /// </summary> 

        public GameObject[] AndyHorizontalPlanePrefab; 

 

        public GameObject AndyHorizontalPlane; 

 

        /// <summary> 

        /// A model to place when a raycast from a user touch hits a feature point. 

        /// </summary> 

        public GameObject AndyPointPrefab; 

 

        /// <summary> 

        /// The rotation in degrees need to apply to model when the Andy model is placed. 

        /// </summary> 

        private  float k_ModelRotation = 0.0f; 

 

        /// <summary> 

        /// True if the app is in the process of quitting due to an ARCore connection error, 
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        /// otherwise false. 

        /// </summary> 

        private bool m_IsQuitting = false; 

 

        /// <summary> 

        /// The Unity Awake() method. 

        /// </summary> 

        ///  

 

        public TextMeshProUGUI Info; 

        int infoCount; 

        public List<InfoText> Messages; 

 

        public void Awake() 

        { 

            AndyHorizontalPlane = AndyHorizontalPlanePrefab[0]; 

            Application.targetFrameRate = 60; 

            modelSelected = 0; 

            count = 0; 

            infoCount = 0; 

            placed = false; 

        } 

 

        /// <summary> 

        /// The Unity Update() method. 

        /// </summary> 

        public void Update() 

        { 

            // If the player has not touched the screen, we are done with this update. 

            Touch touch; 

            touch = Input.GetTouch(0); 

 

            TrackableHit hit; 

            TrackableHitFlags raycastFilter = TrackableHitFlags.PlaneWithinPolygon | 

TrackableHitFlags.FeaturePointWithSurfaceNormal; 

 

            if (Frame.Raycast(touch.position.x, touch.position.y, raycastFilter, out hit) && !placed 

&& !IsPointerOverUIObject()) 

            { 

                // Use hit pose and camera pose to check if hittest is from the 

                // back of the plane, if it is, no need to create the anchor. 

                if ((hit.Trackable is DetectedPlane) && 

                    Vector3.Dot(FirstPersonCamera.transform.position - hit.Pose.position, 

                        hit.Pose.rotation * Vector3.up) < 0) 

                { 

                    Debug.Log("Hit at back of the current DetectedPlane"); 

                } 

                else 

                { 

                    // Choose the Andy model for the Trackable that got hit. 

                    GameObject prefab; 
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                    if (hit.Trackable is FeaturePoint) 

                    { 

                        prefab = AndyPointPrefab; 

                        

                    } 

                    else if (hit.Trackable is DetectedPlane) 

                    { 

                        DetectedPlane detectedPlane = hit.Trackable as DetectedPlane; 

                        if (detectedPlane.PlaneType == DetectedPlaneType.Vertical) 

                        { 

                            prefab = AndyVerticalPlanePrefab; 

                        } 

                        else 

                        { 

                            prefab = AndyHorizontalPlane; 

                        } 

                    } 

                    else 

                    { 

                        prefab = AndyHorizontalPlane; 

                    } 

 

                    // Instantiate Andy model at the hit pose. 

                    Leth = Instantiate(prefab, hit.Pose.position, prefab.transform.rotation); 

                    ModelsList.Add(Leth); 

 

                    LethAnim = Leth.GetComponent<Animator>(); 

                    // Compensate for the hitPose rotation facing away from the raycast (i.e. 

                    // camera). 

                   // Leth.transform.Rotate(0, k_ModelRotation, 0, Space.Self); 

 

                    // Create an anchor to allow ARCore to track the hitpoint as understanding of 

                    // the physical world evolves. 

                    var anchor = hit.Trackable.CreateAnchor(hit.Pose); 

 

                    // Make Andy model a child of the anchor. 

                    Leth.transform.parent = anchor.transform; 

 

                    placed = true; 

                } 

 

                if (Frame.Raycast(touch.position.x, touch.position.y, raycastFilter, out hit) && 

!IsPointerOverUIObject()) 

                { 

                    var anchor = hit.Trackable.CreateAnchor(hit.Pose); 

                    Leth.transform.position = anchor.transform.position; 

                } 

            } 

                

        } 
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• The next script contains the set of codes for Play, Parts, Instructions, Quit buttons. Also 

when the Play button is activated the script calls the lathe model and places it in the 

environment. The animations linked with the previous and next button along with the 

caption are included in the script. 

public void changeAnimation() 

        { 

            if(modelSelected==0) 

            { 

                count++; 

 

                Mathf.Clamp(count, 0, 8); 

                LethAnim.Play("Facing" + count.ToString()); 

                 

            } 

 

            if (modelSelected == 1) 

            { 

                count++; 

 

                Mathf.Clamp(count, 0, 9); 

                LethAnim.Play("Turning" + count.ToString()); 

            } 

 

            if (modelSelected == 2) 

            { 

                count++; 

                Mathf.Clamp(count, 0, 6); 

                LethAnim.Play("Drilling" + count.ToString()); 

            } 

 

            if (modelSelected == 3) 

            { 

                count++; 

                Mathf.Clamp(count, 0,9); 

                LethAnim.Play("Chamfering" + count.ToString()); 

            } 

 

            if (modelSelected == 4) 

            { 

                count++; 

                Mathf.Clamp(count, 0, 7); 

                LethAnim.Play("Knurling" + count.ToString()); 

            } 

            if (modelSelected == 5) 

            { 

                count++; 

                Mathf.Clamp(count, 0, 8); 

                LethAnim.Play("TaperTurning" + count.ToString()); 

            } 
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            changeTextNext(); 

        } 

 

        public void RepeatANimation() 

        { 

            LethAnim.Play("Facing" + count.ToString()); 

        } 

 

        public void PrevAnimation() 

        { 

            if (modelSelected == 0) 

            { 

                count--; 

                Mathf.Clamp(count, 0, 8); 

                LethAnim.Play("Facing" + count.ToString()); 

            } 

 

            if (modelSelected == 1) 

            { 

                count--; 

                Mathf.Clamp(count, 0,9); 

                LethAnim.Play("Turning" + count.ToString()); 

            } 

 

            if (modelSelected == 2) 

            { 

                count--; 

                Mathf.Clamp(count, 0, 6); 

                LethAnim.Play("Drilling" + count.ToString()); 

            } 

 

            if (modelSelected == 3) 

            {  

                count--; 

                Mathf.Clamp(count, 0, 9); 

                LethAnim.Play("Chamfering" + count.ToString()); 

            } 

 

            if (modelSelected == 4) 

            { 

                count--; 

                Mathf.Clamp(count, 0, 7); 

                LethAnim.Play("Knurling" + count.ToString()); 

            } 

 

            if (modelSelected == 5) 

            { 

                count--; 

                Mathf.Clamp(count, 0, 8); 

                LethAnim.Play("TaperTurning" + count.ToString()); 

            } 
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            changeTextPrev(); 

        } 

 

        public void placeObject() 

        { 

            placed = false; 

        } 

 

        public void RotateObj() 

        { 

            k_ModelRotation = 1; 

        } 

 

        public void ChangeAnim() 

        { 

            print(Dropdown.value); 

            modelSelected = Dropdown.value; 

            Info.text = Messages[modelSelected].infoMessages[0]; 

            AndyHorizontalPlane = AndyHorizontalPlanePrefab[Dropdown.value];    

        } 

 

 

        public void PartsAnim(int index) 

        { 

            modelSelected = index; 

            AndyHorizontalPlane = AndyHorizontalPlanePrefab[index]; 

        } 

 

        public void QuitApp() 

        { 

            Application.Quit(); 

        } 

 

        public void changeTextNext() 

        { 

            infoCount++; 

            Info.text = Messages[modelSelected].infoMessages[count]; 

        } 

 

        public void changeTextPrev() 

        { 

            infoCount--; 

            Info.text = Messages[modelSelected].infoMessages[count]; 

        } 

 

        public void Reload() 

        { 

            SceneManager.LoadScene(0); 

        } 
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        public void FreeplayScene() 

        { 

            SceneManager.LoadScene(1); 

        } 

 

        private void _ShowAndroidToastMessage(string message) 

        { 

            AndroidJavaClass unityPlayer = new 

AndroidJavaClass("com.unity3d.player.UnityPlayer"); 

            AndroidJavaObject unityActivity = 

                unityPlayer.GetStatic<AndroidJavaObject>("currentActivity"); 

 

            if (unityActivity != null) 

            { 

                AndroidJavaClass toastClass = new AndroidJavaClass("android.widget.Toast"); 

                unityActivity.Call("runOnUiThread", new AndroidJavaRunnable(() => 

                { 

                    AndroidJavaObject toastObject = 

                        toastClass.CallStatic<AndroidJavaObject>( 

                            "makeText", unityActivity, message, 0); 

                    toastObject.Call("show"); 

                })); 

            } 

        } 

 

        private bool IsPointerOverUIObject() 

        { 

            PointerEventData eventDataCurrentPosition = new 

PointerEventData(EventSystem.current); 

            eventDataCurrentPosition.position = new Vector2(Input.mousePosition.x, 

Input.mousePosition.y); 

            List<RaycastResult> results = new List<RaycastResult>(); 

            EventSystem.current.RaycastAll(eventDataCurrentPosition, results); 

            return results.Count > 0; 

        } 

    } 

 

} 

 

 

 

 

 

 

 

IR@AIKTC-KRRC

ir.aiktclibrary.org



 

VIRTUAL TRAINING OF LATHE MACHINE USING AUGMENTED REALITY 

 

Department of Mechanical Engineering, AIKTC, New Panvel, Navi Mumbai                                                       50 

 
 

CHAPTER 7 

LAUNCHING THE ANDROID APPLICATION 

• First install the APK in your android phone and make sure you have Google Play Services 

for AR installed beforehand. 

• Now open the application and it will show this main screen.  

 

 

Figure 7.1: Application Main Screen 

• This is the main screen where there are all options are available. The power is used to quit 

the application. The dropdown menu will give access to all operations. There are many 

operations including Facing, Turning, Drilling, Chamfering, Knurling Taper Turning. 

Select any one operation and click on play button to start the operations in AR 

 
Figure 7.2: Dropdown Menu 
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Figure 7.3: Instructions Panel 

• First, we will start with the INSTRUCTIONS. Read all the instructions 

carefully before proceeding with the AR. 

 
Figure 7.4: Parts Button Operation 

 

• Return to main menu by clicking the back button and click on Parts button 

• When the camera activates focus it on the ground and stand at least 1m away 

from the surface to be detected. Then grids will appear on the ground surface 

which is detected. Now click on the grid and the lathe will appear.  The user can 

walk around the lathe and view it closely.  

• Return to main menu and now click on free play. The joystick button will rotate 

the lathe. The horizontal and vertical buttons are used to control the carriage 

and tailstock respectively. Click on the ON button to start machining  
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and use the buttons to move the operate the machine. The reset button will 

reset the machine to original position.  

 

 

Figure 7.5: Free Play 

 

• After free play return to main menu and select Turning operation from the 

dropdown menu.  

• Follow the steps as earlier to place the lathe in the environment  

• Once the lathe appears now click on the next button > to start with the first step 

and to go back to previous step click on previous < button.  The following 

images show the stepwise procedure to perform the turning operation in AR  

 

 
Figure 7.6: Turning Operation 
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Figure 7.7: Step One 

 
Figure 7.8: Step Two 

 
Figure 7.9: Step Three 
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Figure 7.10: Step Four 

 
Figure 7.11: Step Five 

 
Figure 7.12: Step Six 
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Figure 7.13: Step Seven 

 
Figure 7.14: Step Eight 

 
Figure 7.15: Step Nine 
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Figure 7.16: Step Ten 

• In this way the turning operation is performed in AR. Now user can select from the list of 

operations and view them in AR. Now select the facing operation and follow the steps. 

 
Figure 7.17: Facing Operation 

 
Figure 7.18: Facing Step One 
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Figure 7.19: Facing Step Two 

 
Figure 7.20: Facing Step Three 

 
Figure 7.21: Facing Step Four 
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Figure 7.22: Facing Step Five 

 
Figure 7.23: Facing Step Six 

 
Figure 7.24: Facing Step Seven 
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Figure 7.25: Facing Step Eight 

• Similarly, we have Drilling, Chamfering, Knurling, Taper turning operations  

 
Figure 7.26: Chamfering  

 
Figure 7.27: Chamfering Step One 
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Figure 7.28: Chamfering Step Two 

 
Figure 7.29: Chamfering Step Three 

 
Figure 7.30: Chamfering Step Four 
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Figure 7.31: Chamfering Step Five 

 
Figure 7.32: Chamfering Step Six 

 

 
Figure 7.33: Chamfering Step Seven 
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Figure 7.34: Chamfering Step Eight 

 
Figure 7.35: Chamfering Step Nine 

Figure 7.36: Drilling 
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Figure 7.37: Drilling Step One 

 

 
Figure 7.38: Drilling Step Two 

Figure 7.39: Drilling Step Three 
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Figure 7.40: Drilling Step Four 

 
Figure 7.41: Drilling Step Five 

 
Figure 7.42: Drilling Step Six 
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CHAPTER 8 

FUTURE SCOPE 

• Design of Machines: 

As for now LATHE Machine is been designed by us and used in our project. Furthermore 

machines (i.e., Grinding machine, Milling Machine, Drilling Machine, etc.) can be designed. 

 

• Training of other machines: 

As for now only training for LATHE Machine is been put in the application which we had 

developed. Further after designing of other machines (i.e. Grinding machine, Milling Machine, 

Drilling Machine, etc.), training that particular machines can also be added. 

 

• Adding AR Free play/ Hands On: 

As for now the Free play/ Hands on is in 3D mode. Further the Free Play/ Hands on will be 

added in AR mode so that the user can switch the free play mode in AR mode or 3D Mode as 

per his/ her convenience. 

 

• Uploading Application on Play store: 

Developed Application after sorting out necessary legal issues will be uploaded on Google Play 

Store. 

 

• Building the application for Apple: 

As for now the application is only been build for Android phones (i.e. apk) further the 

application will also be builded for Apple phones (i.e. iOS) 

 

• Uploading Application on Apple store: 

Once the iOS version of the application will be build it will be uploaded on Apple Store after 

sorting necessary legal stuffs.  

 

• A Bon For Students: 

Students across the global can download this application and they the use these application for 

learning Machine any time anywhere. 
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• Interior decoration Application: 

An application for interior decoration can be made. With the help of that particular application, 

we can show the consumer the household stuff that we want to sell them in Augmented Reality 

so that they can have a clear idea how will the product look in the real world. 

 

• Architecture Field: 

An AR Application of different layouts of an entire building can be developed and it can be 

used to give the idea to the builders and the peoples those who would like to buy house in the 

building how the final Building or Apartment or the Bungalow would look after complete 

construction. 
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CHAPTER 9 

RESULT/CONCLUSION 

 

• The application is very user friendly. 

 

• Application saves time of the student as well as teacher. 

 

• Different operations (i.e. Turning, Facing, Chamfering, Taper turning, Knurling, 

Drilling) can be performed. 

 

• User can also perform free play (in 3D mode). 

 

• Application along with time also saves money. 

 

• Application provides a new level of interactive experience. 

 

• Allows the training of LATHE Machine without any risk. 

 

• The AR LATHE Application provides a much-enhanced sense of reality than any other 

technology in use. 

 

• The instructions provided in the application makes it easy to understand the workflow. 

 

• The application reduces the difference between the LATHE Machine which is digitally 

generated, and which is real in physical world. 

 

• The experience of the application developed using AR technology is of high order and 

delivers a great user experience. 

 

• Due to AR technology used in developing the application, information become more 

realistic. 
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